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What is a Memory Lab? 
The Memory Lab is a service offered by Las Vegas-County Library District. It's meant to 
help preserve and share media that is in danger of physical deterioration and technical 
obsolescence as the equipment required to use it becomes harder to find. 

Library customers can use The Digital Memories Preservation Lab equipment to 
digitize, edit, and store personal media such as home movies on videotape; images 
including photographic prints, slides, and negatives; and audio cassette tapes. We 
provide the equipment and basic help, and then it’s up to you to transfer your media. 

This project was initiated with help from our Executive Director. 

Why Should I Care about Personal Archiving? 

Daily organization 
Personal collections are larger than ever, spanning physical things like keepsakes and 
journals, to digital things like Word documents, photographs, email, and video. Taking 
steps to care for your stuff will help you locate, reference, and re-use what you create. 

Legacy 
What you produce purposefully (like a home movie or photograph) and what you 
produce in daily life (like a calendar appointment or email) could be important for your 
loved ones and for the cultural record. 
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How to Reserve the Digital Memories Preservation Lab 

 
1. Must have a library card in good standing to book an appointment. 
2. Navigate to https://thelibrarydistrict.org/  

a. Select: Using this Library 
b. Select: Digital Media Preservation Lab 
c. Select: Book an appointment (Located under “How to Use the Digital 

Memories Preservation Lab”) 
3. Navigate the https://lvccld.libnet.info/roomlist Select type: Digital Memories 

Preservation Lab 
a. Take note of which location you are booking. 

4. Select Book Room (or Details then Book Room) for the scheduling. 
a. Green: Available  
b. Black: Unavailable  
c. Red: Clash/Time Conflict  
d. Yellow: Setup/Breakdown (Library Use) 

5. From the Available Time Listed (up to 4 hours) Block out the times allowing a 30 
min buffer between your appointment and the next scheduled. 

6. Sign Participant Release Form at the beginning of your first session. If you are 
younger than 18, parental/legal guardian consent is required. 

7. Arrive for your first session 15 minutes early. Check-in with staff at the computer 
lab desk. (Staff may inspect your media to ensure it does not harm the 
equipment.) 

https://thelibrarydistrict.org/
https://lvccld.libnet.info/roomlist
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Identify Formats 

This guide is designed to help you identify the format(s) of your items and contains 
formats that the Memory Lab is able to digitize at this time.  

Audio 

Compact Cassette/Standard Audio Cassette 

 
• Compact Cassette logo on cassette  
• Introduced in 1962  
• Used for professionals and amateur recordings  
• Likely polyester or acetate substrate  
• Dimensions: 4’’ x 2.5’’ x ½’’  
• Typically made of plastic  
• Tape width: 1/8’’  
• Each tape holds 30 to 120 minutes of content  
• Most have 4 track stereo configuration with Tracks 1 & 2 on “Side A” and tracks 3 

& 4 on “Side B”  
• Common Brands: TDK, Maxell, & Dolby 
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CD  

 
• Introduced in 1989  
• Variations of CDs: R/RW/ROM  
• Typical capacity 700MB / 80min of audio  

DVD  

 
• Introduced in 1995  
• Variations of DVD: R/RW/ROM, etc. 
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8mm  

 
• Introduced in 1932  
• Used primarily by amateurs, but some were made available in this format for 

home use.  
• Acetate and Polyester substrates 
• 8mm wide, perforations on 1 edge  
• Color or black & white.  
• Usually silent, but magnetic sound available  
• Negative, positive, composite  
• Image will likely be blurry- this was a form of film for amateurs.  
• If the film is Kodak it will have edge code symbols that represent the year the film 

was made.  
• DO NOT TOUCH- handle only the sides or use gloves 

Super 8mm  

• Introduced in 1965 
• Used primarily by amateurs, but some were made available for home use.  
• Acetate and Polyester substrates • 8mm wide, perforations on 1 edge, that are 

smaller than regular 8mm.  
• Color or black & white 
• Silent or sound 
• Negative, positive, composite perforation of Super 8 is smaller. 
• DO NOT TOUCH- handle only the sides or use gloves * Super 8 and 8mm are 

both 8mm wide, but the perforation of Super 8 is smaller.  
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VHS  

 
• Introduced in 1976  
• Variation: S-VHS  
• Used for professional and consumer recordings 
• VHS Logo on upper right hand corner  
• Dimensions 7.375’’ x 4.0625’’ x 1’’ 
• Typically, black plastic with white hubs and clear windows to show tape. 
• Tape width is ½ inch.  
• Sometimes in a plastic container, or paper sleeves 
• Common Brands: Sony, JVC, Panasonic, Fuji, Maxwell, & Q. 

VHS-C  

 
• There will be a VHS-C logo somewhere on the middle of the tape  
• Tape width is ½ inch  
• Dimensions: 3.625’’ x 2.25’’ x 0.8’’  
• Typically, black plastic with a white hub and clear window. 
• Common Brands: Sony, JVC, Fuji, TDKI, Panasonic  
• Can be played/digitized in a VHS player ONLY with an adapter. (Adapter shown 

in example) 
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Betamax (Only Available at West Charleston Library) 

 

 
• Introduced in 1975  
• Developed by Sony  
• Dimensions 6.14” x 3.75” x 1’’   
• Tape lengths: L-125 , L-165, L-250, L-370, L-500, L-750, and L-830  
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MiniDV  

 
• Introduced in 1995  
• aka DV or DVC  
• Used for professional recordings and amateur  
• Cassette, 1/4” tape width  
• Logo on the left-hand side 
• Dimensions 2.56’’ x 1.88’’ x 7/16’’ 
• Tape width 5/16 inch (8mm)  
• Most common dark gray tape with a light blue antistatic cover and 1 clear window  
• Often stored in clear hinged plastic box 

Video8  

• Introduced in 1986  
• Variation: Hi8, introduced in 1989  
• Used primarily for amateur recordings 
• Tape width: 0.3125’’ (8mm)  
• Dimensions: 3.69’’ x 2.38’’ x 0.56’’  
• There will be a Video8 logo somewhere on the front side of the near the clear 

window • Typically, black plastic with white hub and clear window  
• Common Brands: Sony, Fuji, Panasonic 
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Digital 8 Tape 

 
• There will be a Hi8 logo or Digital8 logo somewhere on the front side of the tape 

near the clear window  
• Digital8 is recorded on standard Hi8 tapes. There may not be any distinguishing 

marks to indicate the recording is Digital 8.  
• Tape width: 0.3125’’ (8mm)  
• Dimensions: 3.69’’ x 2.38’’ x 0.56’’  
• Typically, black plastic with white hub and a clear window  
• Common Brands: Sony, Fuji, Panasonic  

Hi8 Tape 

 
• There will be a Hi8 logo somewhere on the front side near the clear window  
• Dimensions: 3.69’’ x 2.38’’ x 0.56’’  
• Tape width: 0.3125’’ (8mm)  
• Typically, black plastic with white hub and clear window  
• Common Brands: Sony, Fuji, Panasonic 18 
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Film 

35mm Slides  

 
• Are Positive 

o Meaning you can see the image clearly as it was taken  
• Most are mounted in cardboard or plastic  
• When unmounted, Slides have exactly 8 perforations on both sides.  
• Horizontal Orientation (Regardless of image orientation) 

Film Positive  

• Can be black & white or color  
• The image will look just as prints 
• The cameras “reversals” they are made from negatives  
• Can be scanned and digitized  
• Through a chemical process can be processed into print • Positive film can be 

individual, strips, or framed  

Film Negative  

 
• Can be Black & White or Color  
• The cameras “originals”  
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• Negatives are inverted  
o The image on the film is the reverse colors and luminescence of an image 

• Typically comes in long strips  
• Must be developed and processed to get a printable image 

Mixed Media Storage (Audio & Video) 

Floppy Disk  

 
• Floppy disks look like the Save Icon!  
• Size of floppy disk is actual measurement  
• 3.5’’ Floppy Disks are 3.5 inches  
• Common Brands: IBM & Memorex 
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What We Sell 

USB Flash Drive 

 
• Known as a USB stick, USB thumb drive or pen drive  
• A plug-and-play portable storage device that uses flash memory and is 

lightweight.  
• When plugged into the USB port, the computer's operating system (OS) 

recognizes the device as a removable drive and assigns it a drive letter. 
• The drives support Microsoft Windows, Linux, MacOS, Linux and many BIOS 

boot ROMs. 
• Sold by the library for $5.00 

MicroSD Card 

 
• A Secure Digital (SD) card is a tiny flash memory card designed for high-capacity 

memory  
• Used by various portable devices, such as car navigation systems, cellular 

phones, e-books, PDAs, smartphones, digital cameras, music players, digital 
video camcorders and personal computers. 

• Sold by the library for $6.00  
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Compression Software & DVD Playable Software 

Handbrake 

Handbrake  is used for compressing videos. It has the ability to convert and 
compress a video from 100GB to 4GB. The logo for handbrake is a pineapple and a 
fruity beverage.  

 
1. Insert storage device 
2. Open HandBrake 
3. Open your video file using Open Source 
4. Select Video resolution and File format 
5. Click Open 
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Adjust the Settings 

 
1. Choose video resolution: Select the Preset dropdown menu. 
2. Select General 
3. Select Fast 720p 30, Fast 1080p 30 or a resolution you prefer 
4. Choose video file format: Select the Format dropdown menu. 
5. Select MP4 or other file format you prefer. 
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Select Where to Save File 

 
1. Near the bottom, you will find the Save as text box. 
2. Under Save as make sure the file extension is part of the file name. If the file 

extension is not included in the file name, the video will not play on all platforms 
3. Click Browse (near bottom right) 
4. Selected the storage device you brought with you and hit “Choose Other Side” it 

will save under the HandBrake folder. 

Compressing Video File 

 
1. Press the green Start button (near the top of the HandBrake window). This will 

compress your file, making it a more reasonable size. 
2. The compressed video file will automatically save to the storage device that you 

selected. 
3. When the file is finished compressing, close HandBrake. 
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Saving Video File 

 
• If you change the save location, the files will be on your device. 
• If you did not change the save location, the files will be saved to the HandBrake 

Files folder. 
• Check your storage device to make sure that your movie is saved. 
• You’re done! 
• Repeat Capture and Compressing on as many clips as you have time for! 

Finishing Your Appointment 

1. Double check your file 
2. Don't forget your tape 
3. Eject external hard drives, memory cards, and more by clicking on the eject icon 

next to the name of the device in the Finder window. 
4. Tell Staff you are done!  
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Toast DVD 

Roxio Toast DVD  is the easiest and fastest way to create DVDs on your Mac. 
Toast DVD is the perfect companion for iMovie, making it easy to share your movies 
with friends and family. The logo for Toast DVD is a teal toaster with a DVD and film 
strip coming out of the top. 

 

Making a DVD 

DVDs produce high quality video discs with full menu navigation and 
Dolby Digital sound. 

• Standard DVD-Video can hold approximately 2.5 hours of video or Slideshows 
• Dual-layer DVD-Video discs can hold approximately 5 hours at an average 

quality level. 

1. Open Toast DVD Application 
2. Choose DVD-Video from the format selection menu. 
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3. Click the Options button, if necessary, to reveal these optional disc settings: 

 
a. Menu Style: Choose a style for the menu background image, text, and 

buttons. 
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b. Quality: Toast must compress video to fit onto the disc. Choose the quality 
you want to have for the compressed video. Better quality takes longer to 
process: 

i. Good: Suitable for simple video, such as people talking—fastest 
processing time. 

ii. Better: Suitable for most video—average processing time. 
iii. Best: Suitable for complex video, such as fast motion—slowest 

processing time. 
iv. Custom: To create a custom quality level, click Customize and 

choose the Custom option from the Encoding tab. 
c. Auto-play disc on insert: Select this option to automatically play the first 

video, slideshow, or playlist when this disc is inserted into a player. The 
main menu is not displayed, but you can access it by pressing the MENU 
button on the player’s remote control. 

d. Play all items continuously: Select this option to automatically play each 
video or slideshow on the disc without first returning to the main menu. 

e. Include DVD-ROM content: Select this option to include additional data in 
the ROM portion of the disc. This data will be accessible when the disc is 
used on a Macintosh or Windows computer.  

4. Click Customize for additional disc settings. 
5. Add video files to the disc by dragging and dropping them into the Content Area 

from your hard disk or the Media Browser. 

 
6. Insert a blank, recordable DVD. 

a. Optional: Change the destination recorder and number of copies at the 
bottom of the screen. 
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7. Click the red Burn button at the bottom right of the Toast window. 
a. Toast displays a progress bar and status information as it records your 

disc. 

 
8. You can preview a DVD-Video disc prior to burning an actual disc by saving it as 

a disc image file. 

To Preview the DVD 

1. Instead of recording, select File > Save as Disc Image. 
2. Give the disc a name, if you are prompted to do so. 
3. Select a name and destination for the disc image file. 
4. Click Save. 

a. The disc image file is created. 
5. Select the file, Control-click, and choose Services > Mount It. 
6. Use the DVD Player software included with Mac OS X to preview the DVD. 

Making a High Definition DVD 

High Definition DVD is a unique type of video disc which allows you to author HD video 
to DVD, for playback in true high definition. This gives you the ability to create HD video 
discs without owning a Blu-ray Disc recorder. Although you are recording to standard 
DVD discs with this project, you can only view the finished project on a Blu-ray Disc 
player. 

• A standard, single-layer DVD can hold approximately 30 minutes of HD video.  
• A dual-layer DVD can hold approximately one hour of HD video. 

o While Toast will allow you to add more than these lengths of video, adding 
additional video requires the video be compressed further and results in a 
lower quality video. 

1. Choose DVD-Video from the format selection menu. 

 
2. Click the Options button, if necessary, and select High Definition DVD as the 

format.  
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a. The other disc settings and options available are identical to those 
available when creating a DVD. 

3. Add your HD video files to the disc by dragging and dropping them into the 
Content Area from your hard disk or the Media Browser. 

 
4. On the disc gauge at the bottom of the window, select DVD or DVD DL as your 

target media type. 
5. Insert a blank, recordable DVD. 

a. Optional: Change the destination recorder and number of copies at the 
bottom of the screen. 

6. Click the red Burn button at the bottom right of the Toast window.  
a. Toast displays a progress bar and status information as it records your 

disc. 

 

Finishing Your Appointment 

1. Double check your file 
2. Don't forget your tape 
3. Eject external hard drives, memory cards, and more by clicking on the eject icon 

next to the name of the device in the Finder window. 
4. Tell Staff you are done! 
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Using the Video Transfer Station 

Sony DSR-45 DVCAM / DV / MiniDV VTR Player/Recorder 

 

To Get Started 

Make sure that the DVCAM is powered on. 
To monitor audio during the digitization process make sure that the speaker is powered 
on by turning the knob clockwise (to the right). 

What You Will Be Using 

The software you will be using is BlackMagic Media Express. The logo is a film reel 

inside a stopwatch housing.  Also the optional iMovie whose logo is a purple 

star with a white camera in the middle.   The hardware you will be using is 
the Sony DSR-20 DVCAM / DV / MiniDV VTR Player/Recorder.  
 
The DSR-45 is a videocassette recorder with a compact chassis. Equipped with a 2-
inch3 built-in LCD, the DSR-45 displays information including: audio level, system 
status, and the working image as they are needed.  
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The controls that you will use are Eject, Play, Stop, Rewind, and Fast Forward 
 

 
Never press record on the device as this will record over the movie 
Make sure the DV Cam deck is powered on, the power button is on the upper left-hand 
side of the deck. When the light turns green the deck is on. 

Connect to the DV Cam 

Make sure the Audio and Video source selector buttons are on 1 
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Loading the Tape 

There are two types, Regular DV and Mini DV 
When loading Mini DV place the tape directly in the middle and load until the deck 
adjusts the size. 

Capturing Video File 

 

1. Open BlackMagic Media Express  
2. When BlackMagic opens make sure that the Log and Capture tab is selected 
3. The preview window will allow you to see what is being played on the DV Cam. 
4. Make sure that the DV tape is at the start position of the video or rewind the tape. 
5. Press Capture at the bottom of the application. Then press play on the Sony 

DSR-45 
6. The computer will start recording. 
7. When the video has finished playing, click the Capture button again to stop the 

recording.  
8. You should now have a complete .mov file of the tape. Don’t forget to eject your 

tape and take it with you! 

• You can stop your DV or MiniDV tape at any time if you only want to capture part 
of the tape. 

• DV and MiniDV tapes can be anywhere from 5 minutes to 2 hours long. 

Saving Video File 
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In BlackMagic Media Express When you hit capture the second time to end the 
recording of the video, BlackMagic automatically saves a .MOV file to the desktop. 

Compressing Video File 

Open iMovie and click Create New and select movie 

 

 
Import your file from the saved location by clicking the Import Media button.  
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• File > Share > File 
• Name and describe your title.  
• The settings should be 

o Format Video and Audio 
o Resolution 540p 60s 
o Quality High 

• Click Next  
• Make sure the “Where” is located on your device.  
• Click Save 
• When your file is done, iMovie will let you know with “Share Successful” 

Finishing Your Appointment 

• Double check your file 
• Don't forget your DVCam tape 
• Eject external hard drives, memory cards, and more by clicking on the eject icon 

next to the name of the device in the Finder window. 
• Tell Staff you are done! 
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Video8 / Hi8 / Digital8 

 

What You Will Be Using 

The software you will be using is Blackmagic Media Express. The logo is a film reel 

inside a stopwatch housing.  Also the optional iMovie whose logo is a purple 

star with a white camera in the middle.   The hardware you will be using is 
the Sony GV-D800 Digital Walkman which is a compact and portable Walkman for 
playing, recording, and editing your footage that features a 4" LCD monitor. The GVD-
800 is a backward compatible VCR allowing the Hi-8 and 8mm tape playback. The 
controls that you will use are Power On/Off, Eject, Play, Stop, Rewind, and Fast 
Forward.  
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To eject press and slide. Do not press record on the device or it will record over the 
tape. 

Load the Tape 

1. Make sure the tape deck is on 
2. Load the tape into the deck by pushing and sliding the Eject switch to the right. 

The tray will automatically open. The tape should go into the metal slot face-up 
with the top of the video cassette sliding in first.  

3. Gently push the tape deck closed. You will hear the deck making noise after it 
closes which is normal. 

a. The tape can be rewound by pressing the REW button on the tape deck 

Connect to the Sony GV-D800 Digital Walkman 
Make sure the Audio and Video source selector buttons are on 2 
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Capturing Video File 

1. Open BlackMagic Media Express 
2. When BlackMagic opens make sure that the Log and Capture tab is selected 
3. The preview window will allow you to see what is being played on the Sony GV-

D800 Digital Walkman. 
4. Make sure that the video cassette tape is at the start position of the video or 

rewind the tape. 
5. Press Capture at the bottom of the application. Then press play on the Sony GV-

D800 Digital Walkman. 
6. The computer will start recording. 
7. When the video has finished playing, click the Capture button again to stop the 

recording.  
8. Then, press the Stop button on the Sony GV-D800 Digital Walkman. 
9. You should now have a complete .mov file of the tape. Don’t forget to eject your 

tape and take it with you! 
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• You can stop your video cassette tape at any time if you only want to capture 
part of the tape. 

• Video8/Hi8/Digital8 tapes can be up to 2 hours long. 

Saving Video File 

In BlackMagic Media Express When you hit capture the second time to end the 
recording of the video BlackMagic automatically saves a .MOV file to the desktop.  

Finishing your appointment 

• Double check your file 
• Eject your video cassette from the Sony GV-D800 Digital Walkman 
• Eject external hard drives, memory cards, and more by clicking on the eject icon 

next to the name of the device in the Finder window. 
• Tell Staff you are done! 

Wolverine Movie Maker Pro 

 
You will be using the Wolverine Movie Maker Pro which is a standalone converter. The 
Wolverine creators HD .MP4 video at 20 frames per second. It takes approximately 10 
minutes to capture one minute of film. 

Setting up the Wolverine 

• First make sure you have head and tail leader on your film roll 
• Insert the SD Card in the back of the Wolverine 
• MovieMaker Pro can only take a SD/SDHC memory card up to 32 GB maximum. 
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• Using a Micro SD Card with adapter, or SDXC Card, or memory card that is 64 
GB or above capacity, which is not compatible with MovieMaker Pro will lead to a 
“Card Error” message to appear on the screen. 

• Make sure the SD/SDHC card is unlocked (white tab in forward position). 
• Insert and push the SD/SDHC card inward until it clicks. (Improper insertion may 

damage the card reader or the SD/SDHC card). 
• To dismount/eject the SD/SDHC card, first push the card in then release, instead 

of pulling it out directly. (MovieMaker Pro will Power off automatically if the 
SD/SDHC card is being mounted/dismounted.  

 

8MM and Super 8MM Film 

Will require an SD card 
Approx. time based on film reel length 

Reel Length Time Length 

3” reel (50 feet) 2-3 minutes 

4” reel (100 feet) 5-6 minutes 

5” reel (200 feet) 12-14 minutes 

6” reel (300 feet) 19-22 minutes 

7” reel (400 feet) 26-29 minutes 

8” reel (500 feet) 34-37 minutes 

9” reel (600 feet) 41-44 minutes 

Mount the Reels and Film 
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If your film reel has an 8 mm mounting hole, mount the reel directly to the left shaft, 
otherwise use the red color reel adapter. If adapters are needed, always place the RED 
color adapter on LEFT side: GRAY adapter on the RIGHT side. 

 
• Mount empty reel on the right shaft. (Empty wheel is provided on the shaft). 
• Follow the Film Routing Diagram printed on the face of MovieMaker Pro to route 

the film. Follow the winding scheme printed on the machine to generate better 
quality videos. 

• Slide Open the flap door, position film sprocket holes at the top. Place film 
underneath the 3 white tabs. Otherwise, the recorded videos will be jittery. 

Steps to Place Film on Table 

1. Place and hold film underneath Tab #1 
2. Twist film slightly and clip film underneath Tab #2 
3. Twist film slightly and clip film underneath Tab #3 

 
• Make sure the film is properly placed underneath all 3 white tabs, then close the 

flap door. 
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Menu Selections 

Press the Menu button. Use the Up or Down arrow button to highlight the Menu 
selection and then press Enter. 
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Record 

1. Slide the Film Selection Lever left (8 mm) or right (Super 8) to select the proper 
film type. Then press the Enter button. 

 
2. Press Enter/Start/Stop button to start recording. While recording is in process, a 

red dot at upper left corner blinks. 
3. Press Enter/Start/Stop button to stop recording. 

Playback 

1. Press the Menu button, highlight the Playback selection, and then press Enter. 
2. Press Up/Down arrow button to select the film file to be playback, then 

Enter/Start. 
3. Press Enter/Stop to pause the playback. 
4. Press the Menu button one time to enter Edit mode. Highlight Return (go back to 

Playback) or Delete (delete the current file). 
5. Press the Menu button twice to go back to the Record mode or Main/Home 

menu. 

Rewind 

1. Rewind film from Light Table and swap reels. Place the empty take-up reel on 
the right side shaft and place sprocket holes on the outside (as shown). If a reel 
adapter is needed, always place the gray adapter on the right side/take-up reel. 

2. Follow the film rewind routing diagram (the dotted lines) printed on the Movie 
Maker Pro and follow the instructions on the screen. 

3. Press Enter button to Start/Stop the rewinding process. 

Exposure 

Exposure Value/brightness needs to be adjusted before recording if default setting (0.0) 
is off. 

1. Adjustable exposure range is from 2.0 to -2.0. 
2. Press Up/Down key to change the value and press Enter to complete the 

change. 
3. The default setting is 0.0. Negative value provides a darker effect and Exposure 

2.0 shows the brightest result. 
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Sharpness 

If Sharpness adjustment is needed, make a change before recording. 
1. Sharpness range is from Low to High. The default setting is Medium. 
2. Press Up/Down to change the value and press Enter to complete the change. 

 

USB 

Plug in the included USB cable to upload recorded MPF files. The SD/SDHC memory 
card is read as an External Drive, called No_Name drive (G:)*. The stored MP4 files are 
located under the directory of FilmScanner/MOVIE.  
*Note: (G:) may vary computer to computer. 

Frame ADJ (Adjustment) 

You can make adjustments of Movie Registers (the film center, X and Y and zoom-
in/out factor on screen). If frame adjustments are needed, make changes before 
recording. 

 

Finishing Your Appointment 

• Double check your file 
• Eject your SD/SDHC Card from the MovieMaker Pro 
• Tell Staff you are done! 
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BETAMAX Player (Only Available at West Charleston Library) 
 

 

What You Will Be Using 

The hardware you will be using is the Sony SL-HF2000 and the Wolverine TransMedia 
All-in-one. The optional software is iMovie whose logo is a purple star with a white 

camera in the middle.    
 
Using the Betamax 
Uses the play, stop, rewind, and fast-forward and eject functions. Do not use the record 
function. 
Always insert the tape into the Betamax with the flap side and the clear windows facing 
up.  

 

Prepare the Betamax tape 

• Make sure the Sony SL-HF2000 Super Betamax Player is powered on. 
• Insert Betamax tape 
• Be sure to rewind the tape to the desired position. 
• When the tape is where you wish to capture, press pause. 
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Capturing Video File 

• Select “Video à USB/Card” on the Wolverine TransMedia All-in-one. Plug-in 
USB or SD card and press ENTER.  
 

 
• Depending on which device you are saving to. Select “USB” or “Card” and press 

ENTER. 

 
 

• The preview window on the Wolverine TransMedia All-in-one will allow you to 
see what is being played on the Sony SL-HF2000 Super Betamax Player. 

• Make sure that the video cassette tape is at the start position of the video or 
rewind the tape. 

 
• Press REC to start recording at the bottom of the Wolverine TransMedia All-in-

one. Then press play on the Sony SL-HF2000 Super Betamax Player. 
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• Press STOP to end recording the Wolverine TransMedia All-in-one.  
 
 
 
 
 
 

 
• Wait for the popup

 
 
 
 

 
 

The following image breaks down the duration of each Betamax recording type. 
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Wolverine TransMedia All-in-one 

 
 
 

 Power Button – Press and hold down the power button start up the device. 
 
Menu Selections 
Main menu includes six selections as follows. 
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I. VIDEO à USB/Card 
Select “Video à USB/Card”. Plug-in USB drive and press ENTER. Two selections 
(USB, Card) appear. 
 
Record from Video to USB & Record from Video to Card 

1. Verify provided RCA-AV cables (red, white, yellow) are connected. 
2. Select “USB” or “Card” and press ENTER. 
3. Press REC to start recording. Press REC to pause/continue to skip desired 

segments when needed. 
4. Press STOP to end recording.  
5. The recorded files will be saved on USB drive or Memory card under path of 

“MT-ROOT/Record”. 
 

II. USB        Card 
Select “USB       Card” from the man menu, then press ENTER. Two selections 
(USB to Card, Card to USB) appear. Mount devices, make appropriate selection, 
then press REC to start recording. 
 

III. Media Player 
• Do not press EJECT button or open DVD tray while DVD is playing. 
• Use the provided equipment, if there is a problem, please inform staff. 
• Picture playback: 

o Press UP or DOWN to move he curse and press ENTER to view 
pictures. Press UP or DOWN to view pictures in sequence. Or 
press RETURN to exit. 

• Video playback: 
o Press LEFT or RIGHT to control the volume when TV OUT 

(connected HDMI) is connected. 
o Press UP or DOWN to play previous or next video. 
o Press ENTER to pause/resume video playback or RETURN to exit 

video playback mode. 
Formats Supported for Playback through TV out 

• TV Out (HDMI): FULL HD 1080p (1920x1080) 
• Video: AVI, MKV, TS, MZTS, MPD, MOVN. OB, WMV, RM, RMVB 
• Photo: JPG, JPEG, BMP, PNG 
• Audio: MP3, OGG, WMA, MC, FLAC 
• DVD: DVD+R, DVD-RW, DVD+RW, DVD-R discs 

 
IV. Setup 

Burn Type (DATA, Video:) 
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• DATA: A data DVD is that the information can’t be erased and the disk 
can’t be reused later. User can burn multiple files on a blank disc. 

• VIDEO: A video DVD can just have video files written on it. User can only 
burn one file on a disc. 

 
Auto Stop Timer: 
User may set timer for recording. The Auto Stop Timer only apply to AV to 
DVD, AV to USB, and AV to Card. 
 
Auto Chapter: 
The Auto Chapter only apply to AV to DCD, AV to USB, and AV to Card. 
When the setting is “OFF”. The recorded video will be split into 30-minute 
chapters on DVD disc. 
 
Erase Disc: 
All contents of the DVD+RW or DVD-RW discs can be erased. After erasing, 
the contents on the DVD disc cannot be retrieved. The erased DVD disc can 
be reused as blank. 
 
Date Setting: 
Use NAVIGATION buttons to set the time, then ENTER to save. 
 
Time Setting: 
Use NAVIGATION buttons to set the time, then ENTER to save. 
 
Recorded video files created by the unit uses Date and Time information for 
file naming.  
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DVD-VHS Player 

 

What You Will Be Using 

The software you will be using is Blackmagic Media Express. The logo is a film reel 

inside a stopwatch housing.   
 
 
Some Digital Memories Preservation Labs will be using the Wolverine TransMedia All-
in-one instead of Blackmagic Media Express please refer to page 40.  
 
 
Also the optional iMovie whose logo is a purple star with a white camera in the middle.  

 The hardware you will be using is the Sony SLV-D380P 

Using the VCR 

Uses the play, stop, rewind, and fast-forward and eject functions. Do not use the record 
function. 
Always insert the tape into the VCR with the flap side and the clear windows facing up. 
If the tape is a VHS-C you will need the appropriate adapter.  
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Prepare the VHS tape 

• Make sure the SL-VD380P DVD/VCR Combo Player is powered on and the 
Video option is selected 

• Insert VHS tape 
• Be sure to rewind the tape to the desired position. 
• When the tape is where you wish to capture, press pause 

VHS-C 

The equipment can digitize SVHS, VHS, VHS-C and SVHS-C tapes. 
All tapes use half inch tape, however VHS-C and SVHS-C are 3.8 inches smaller in 
length and 1.5 inches smaller in width than regular VHS. 
VHS-C and SVHS-C require an adapter to digitize. 

Using the VHS-C Adapter 

• VHS-C Adapter is located on top of the server rack 
• Remove the adapter out of the insert and place the VHS-C inside. 
• Slide the arrow button slowly until it open the case 
• Press the tape gently into the adapter  
• Slowly close the VHS-C adapter lid back into place 
• You will hear a noise that means the adapter is loading the tape 
• Check to make sure the tape threaded properly 
• Digitize as you would a regular VHS 

Capturing Video File 

• Open BlackMagic Media Express 
• When BlackMagic opens make sure that the Log and Capture tab is selected 
• The preview window will allow you to see what is being played on the Sony SL-

VD380P DVD/VCR Combo Player. 
• Make sure that the video cassette tape is at the start position of the video or 

rewind the tape. 
• Press Capture at the bottom of the application. Then press play on the Sony SL-

VD380P DVD/VCR Combo Player. 
• The computer will start recording. 
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• When the video has finished playing, click the Capture button again to stop the 

recording.  
• Then, press the Stop button on the SL-VD380P DVD/VCR Combo Player. 
• You should now have a complete .mov file of the tape.  
• Don’t forget to eject your tape and take it with you! 

 
*You can stop your video cassette tape at any time if you only want to capture part of 
the tape. 

Saving Video File 

In BlackMagic Media Express When you hit capture the second time to end the 
recording of the video BlackMagic automatically saves a .MOV file to the desktop. 

Using the DVD Player 

• Uses the play, stop, rewind, and fast-forward and eject functions. Do not use the 
record function. 

• Use the Eject button to open the disc tray. 
• Always insert the DVD into the player with the image side facing upright. 
• When the DVD is where you wish to capture, press pause 
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Prepare the DVD 

• Make sure the SL-VD380P DVD/VCR Combo Player is powered on and the 
Video option is selected 

• Push the Eject button to open the disc tray. 
• Insert the DVD 
• Push the Eject button once the disc is inside to close the player. 

Capturing Video File 

• Open BlackMagic Media Express 
• When BlackMagic opens make sure that the Log and Capture tab is selected 
• The preview window will allow you to see what is being played on the Sony SL-

VD380P DVD/VCR Combo Player. 
• Make sure that the DVD is at the start position of the video or at the point you 

wish to record. 
• Press Capture at the bottom of the application. Then press play on the Sony SL-

VD380P DVD/VCR Combo Player. 
• The computer will start recording. 



Digital Memories Preservation Lab Guide Book 
 

Table of Contents 47 

 
 

• When the video has finished playing, click the Capture button again to stop the 
recording.  

• Then, press the Stop button on the SL-VD380P DVD/VCR Combo Player. 
• You should now have a complete .mov file of the DVD. 
• Don’t forget to eject your DVD and take it with you! 

 
*You can stop your DVD at any time if you only want to capture part of the tape. 

Saving Video File 

In BlackMagic Media Express When you hit capture the second time to end the 
recording of the video BlackMagic automatically saves a .MOV file to the desktop. 
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Using the Audio Transfer Station 

TEAC Double Cassette Deck W-1200 

 
The TEAC Double Cassette Deck W-1200 can deliver digital audio at CD-quality (up to 
48kHz/16-bit PCM) to the computer, allowing digital archiving of your cassette tape 
library. Once you have digitized them on a computer, you are able to enjoy your old 
tape-based music library. 

To Get Started 

Make sure that the tape deck is powered on 
To monitor audio during the digitization process make sure that the speaker is powered 
on by turning the knob clockwise (to the right). 
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What You Will Be Using 

The software you will be using is GarageBand. The logo is a black amp speaker with a 

yellow sunburst guitar in front.   For hardware you will be using the TEAC 
Double Cassette Deck W-1200. The TEAC has two cassette deck ports to transfer 
audio from one cassette to another. For the process of digitizing you will only use one of 
them. The controls that you will use are Eject, Play, Stop, Rewind, and Fast Forward. 
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DO NOT press the Record button, this will record over the current tape.  

Loading the Cassette 

• Press the Eject button on the left side. (This will open the deck automatically) 
• Insert the cassette tape with the magnetic tape side down.  

o Cassettes usually have two sides (Referred to as Side A and B or Side 1 
and 2. Make sure the side that you want to record is facing you.)  
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• Gently push the tape deck closed. 

Open GarageBand  

On the computer, click once on the GarageBand icon to Open 
GarageBand will open up to a Cassette Template. 

 

Capturing the Audio 

Make sure that the cassette tape is at the start position of your audio or rewind the tape. 
Press record at the top of the application. Then press play on the TEAC  
The cassette track will start recording. In GarageBand you should see a red recording 
bar moving across the screen. 
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Saving the Audio File 

• Make sure your storage device is connected to the computer 
• In GarageBand on Mac, choose Share > Export Song to Disk. 
• You can rename the exported file, select the name in the Save As field, then 

enter a new name. 
• Choose the location to save the exported file to your storage device from the 

Where pop-up menu. 
• Select the format for the exported file (AAC, MP3, AIFF, or WAVE). 

Finishing Your Appointment 

• Double check your file 
• Don't forget your audio tape 
• Eject external hard drives, memory cards, and more by clicking on the eject icon 

next to the name of the device in the Finder window. 
• Tell Staff you are done! 
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Using the Image Scanning/Transfer Station 
There are two Epson Scanners available. The Epson V850 comes equipped with film 
guide trays for negative and medium format film (120mm) as well as 35mm film slides. 
This scanner is also capable of scanning developed images but does so at a slower rate 
than the Epson FastFoto.  
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The Epson FastFoto is capable of scanning developed photos and documents in a 
range of sizes including 4x6 and 5x7.  

 
Each scanner has its own software program used to scan, edit and store images. 

Using the Epson V850 
The software used for the Epson V850 is called Epson Scan 2. You will find it on the 
right side of the Mac desktop.  

To begin scanning, open up Epson Scan 2. The window that will appear will have a list 
of settings, with the “Preview” and “Scan” options at the bottom.  

To scan a developed image, simply place one photo at a time onto the scanning glass 
with the image face down. Close the lid of the scanner, select the appropriate settings 
and click Scan in the Epson Scan 2 window.  

• “Scan Settings” should be set to “Default” 
• “Mode” should be set to “Photo Mode” 
• “Document Source” should be set to “Scanner Glass” 
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• “Document Type” should automatically be set to “Reflective”.  
• All other settings - including “Image Format” should be set based on the users’ 

preference.  
We recommend considering the file size when selecting settings for “Resolution” and 
“Scanning Quality”. 

 
To scan single 35mm slides, grab the appropriate film guide tray and slide the 35mm 
slides into the slots. Align the triangles on the tray with the triangles on the scanner and 
position the tray so that the notches go into the holes on the scanner. Remove the 
scanner cover from its lid, close the lid and open up the Epson Scan 2 software that is 
on the right side of the Mac desktop. 
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Settings for Positive Slides Should Be Set as Follows 

• “Scan Settings” should be set to “Default” 
• “Mode” should be set to “Photo Mode” 
• “Document Source” should be set to “Transparency Unit” 
• “Document Type” should be set to “Color Positive Film”.  
• All other settings - including “Image Format” should be set based on the users’ 

preference. We recommend considering the file size when selecting settings for 
“Resolution” and “Scanning Quality”. 
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To Scan Positive or Negative Film  

• Grab the appropriate film guide tray  
• Open up the tray clamp, sliding the film into the slots and close the clamp. 
• Align the triangles on the tray with the triangles on the scanner and position the 

tray so that the notches go into the holes on the scanner.  
• Remove the scanner cover from its lid, close the lid and open up the Epson Scan 

2 software that is on the right side of the Mac desktop. 
 



Digital Memories Preservation Lab Guide Book 
 

Table of Contents 58 
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Settings for Positive Film Should Be Set as Follows  

• “Scan Settings” should be set to “Default” 
• “Mode” should be set to “Photo Mode”  
• “Document Source” should be set to “Transparency Unit” 
• “Document Type” should be set to “Color Positive Film”.  
• All other settings - including “Image Format” should be set based on the users’ 

preference. We recommend considering the file size when selecting settings for 
“Resolution” and “Scanning Quality”. 

Settings for Negative Film Should Be Set as Follows  

• “Scan Settings” should be set to “Default”  
• “Mode” should be set to “Photo Mode”  
• “Document Source” should be set to “Transparency Unit” 
• “Document Type” should be set to “B&W Negative Film” OR “Color Negative 

Film” depending on whether the photos were shot to be in black and white or in 
color.  

• All other settings - including “Image Format” should be set based on the users’ 
preference.  

We recommend considering the file size when selecting settings for “Resolution” and 
“Scanning Quality”. 
 



Digital Memories Preservation Lab Guide Book 
 

Table of Contents 60 

 
 
Images scanned will be saved in a folder in Documents called: FastFoto 
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Using the Epson FastFoto 

The software used for the Epson FastFoto is also called Epson FastFoto. You will find it 
on the right side of the Mac desktop.  

 
To begin scanning, open up the Epson FastFoto software. The window that appears will 
have various options at the top; including “Start Scanning”, “Share”, “Upload” and “Edit”. 
 

 
 
Load the photos onto the scanner’s feeder with the image facing you. Note that photos 
are scanned from the back to front; meaning that the photo at the back of the pile will 
appear first. Please follow the loading capacity guide below to ensure the scanner is not 
overloaded. 
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Next, click “Start Scanning” on the Epson FastFoto window. A new window will pop up 
and require information about the photos to be filled out. This information will be used 
so that the system can create organized file names, folders and tags. Once this 
information is added, you can click on the blue “Start Scanning” button at the bottom of 
this new window. Photos will begin to populate the window. Two versions of the photos 
will appear. One is unedited and the other is automatically edited by the system with 
improved photo quality. 

 
Images scanned will be saved in a folder in Documents called: FastFoto. 
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Floppy Disks 

 
• Insert the 3.5 inch Floppy Disk 
• The drive will appear on the desktop. 
• Transfer your files to your device. 
• Copy Files to the Storage Device 
• Highlight all of the files you want to copy from the floppy disk 
• Drag the highlighted files to your chosen storage destination 
• Some older file formats may not be able to open with current operating systems. 

It is still recommended that you move all the files off the Floppy Disk. 
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Finishing Your Appointment 

• Eject the Floppy Disk from the computer by dragging the drive on the desktop to 
the trash can, it will turn into an eject symbol. 

• Eject the physical Floppy Disk from the drive by pressing the button in the upper 
right of the drive. 

• Tell Staff you are done! 

Origbelie DVD R/RW 

 
• Insert the Disc DVD or CD 
• The drive will appear on the desktop. 
• Transfer your files to your device. 
• Copy Files to the Storage Device 
• Highlight all of the files you want to copy from or to the disc. 
• Drag the highlighted files to your chosen storage destination. 
• Some older file formats may not be able to open with current operating systems. 

It is still recommended that you move all the files off the disc. 

What You Can Do with Digitized Files 
• Save them on your computer or external drive 
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• Save them to the Cloud 
• Upload to Social Media Platforms 
• Share with friends and family 
• Create Backups 
• Do not let your hard work go to waste, Protect your digital files and plan for their 

long-term preservation  
• Follow the 3-2-1 of digital preservation 

o Save 3 copies 
o Stored on 2 different media 
o 1 copy off-site 

What Software is available  

• Blackmagic Media Express 3.8.1: Software used for capturing video to the 
computer 

• Epson Scan: Scanner software with options for very high quality scans 
• Handbrake 1.5.1: An open source video compression and conversion tool 
• Gimp Image Editor 2.10: An open source image editor  
• GarageBand 10.4.7: An open source audio capture tool 
• QuickTime Player: Apple tool for video playback and simple editing 
• iMovie 10.3.5: Apples consumer video editing software 
• ToastDVD: DVD Burner for Mac 
• DaVinci Resolve 18.1.1.Build 7 

What Hardware is available 
• Mac Station 
• Input Devices 

o Epson Perfection V850 Pro Photo Scanner User Guide 
o Epson FastFoto Ff-680w Scanner User Guide 
o Sony DSR-20 DVCAM / DV / MiniDV VTR Player/Recorder User Guide 
o Sony Digital Video Walkman GV-D800 (Digital8) User Guide 
o Teac W-1200 Dual Cassette Deck with Recorder User Guide 
o Sony DVD Player/ Video Cassette Recorder SLV-D380P User Guide 

• Output Devices 
o Origbelie DVD R/RW User Guide 
o Chuanganzhuo floppy disk drive User Guide 
o Wolverine MovieMaker Pro 8mm/Super 8 (digital format .mp4) User 

Guide 

https://files.support.epson.com/docid/cpd4/cpd41530.pdf
https://files.support.epson.com/docid/cpd5/cpd55191.pdf
https://www.broadcaststore.com/pdf/model/17001/dsr20.pdf
https://www.sony.com/electronics/support/res/manuals/W000/W0004512M.pdf
https://assets.teac-usa.com/general/W-1200_OM_EFS_vC.pdf
https://www.manualslib.com/manual/160292/Sony-Slv-D380p.html?page=5#manual
https://m.media-amazon.com/images/I/A1tU5A8BxDL.pdf
https://d4804za1f1gw.cloudfront.net/wp-content/uploads/sites/56/2020/10/01110452/Chuanganzhuo-3.5_-USB-External-Floppy-Disk-Drive.pdf
https://www.wolverinedata.com/assets/downloads/MovieMaker_PRO_V_3.0_Manual_.pdf
https://www.wolverinedata.com/assets/downloads/MovieMaker_PRO_V_3.0_Manual_.pdf

